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Устранение неисправностей 
аппаратуры и 
инструментальные средства 
для тестирования программ  
 

STEP 7-Micro/WIN предоставляет инструментальные программные средства, с помощью 
которых вы можете отлаживать и тестировать свою программу. Эти функции включают в себя 
просмотр состояния программы во время ее исполнения в S7�200, выполнение S7�200 
определенного количества циклов и принудительное присваивание значений переменным.  

С помощью таблицы 8�1 вы можете выяснить причину и возможный способ устранения 
неисправностей в аппаратном обеспечении S7�200.  
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Функции для отладки вашей программы 
STEP 7-Micro/WIN предлагает несколько функций для отладки вашей программы: закладки, 
таблицы перекрестных ссылок и возможность редактирования программы во время ее 
исполнения. 

Использование закладок для быстрого доступа к программе 
Вы можете устанавливать в своей программе закладки, облегчающие повторное нахождение 
определенных строк в своей программе. С помощью закладок вы можете перемещаться в 
своей программе к следующей или предыдущей помеченной строке.  

Использование таблицы перекрестных ссылок для проверки ссылок 
в вашей программе 

Таблица перекрестных ссылок дает возможность отображать перекрестные ссылки и 
информацию об использовании элементов вашей программы.  

 Таблица перекрестных ссылок дает список 
всех операндов, используемых в программе, и 
указывает для каждого операнда (столбец 
Element) программный блок (столбец Block), 
сегмент (network) или строку (line) (в столбце 
location [местоположение]) и команду (в 
столбце context), где он используется.  
Вы имеете возможность переключаться 
между абсолютным и символическим 
представлением, чтобы изменять 
отображение всех операндов.  

 

 

 

Рис. 8�1. Таблица перекрестных ссылок 

  
Совет 
Двойной щелчок на элементе в таблице перекрестных ссылок перемещает курсор в 
соответствующее место в программе или блоке.  

Редактирование программы в режиме RUN  
CPU 224, начиная с версии 1.10, и CPU 226, начиная с версии 1.00, поддерживают 
редактирование в режиме RUN. Возможность редактирования в режиме RUN позволяет 
делать небольшие изменения в программе пользователя, не создавая помех процессу, 
управляемому программой. Однако эта функция позволяет выполнять и большие изменения в 
программе, которые могут оказать неблагоприятное воздействие на процесс, и даже могут 
быть опасными.    

 
Предупреждение 
Если вы загружаете изменения в S7�200 в режиме RUN, то эти изменения немедленно 
оказывают воздействие на работу процесса. Изменение в программе в режиме RUN может 
привести к неожиданному поведению системы, что может вызвать гибель или тяжкие 
телесные повреждения персонала и/или нанести вред имуществу.  
Редактирование в режиме RUN должен выполнять только квалифицированный персонал, 
понимающий воздействие редактирования в режиме RUN на систему. 
Для выполнения редактирования в режиме RUN CPU S7�200, находящийся в режиме online, 
должен поддерживать редактирование в режиме RUN и должен находиться в режиме RUN.  

1. Выберите команду меню Debug > Program Edit in RUN [Отладка > Редактирование 
программы в режиме RUN]. 

2. Если проект отличается от программы, находящейся в S7�200, то вы получаете запрос 
на ее сохранение. Редактировать в режиме RUN можно только программу, находящуюся 
в S7�200.  

3. STEP 7-Micro/WIN предостерегает вас от редактирования в режиме RUN и спрашивает,  
желаете ли вы продолжить или прекратить операцию. Если вы щелкнете на Continue 
[Продолжить], STEP 7-Micro/WIN загружает программу из S7�200. Теперь вы можете ее 
редактировать в режиме RUN. При редактировании нет никаких ограничений.  

Совет 
В LAD команды обнаружения положительного фронта (EU) и обнаружения отрицательного 
фронта (ED) представляются с помощью операнда. Для просмотра информации об этих 
командах выберите пункт Cross Reference [Перекрестные ссылки] в меню View [Вид]. В 
закладке Edge Usage [Использование фронтов] перечислены номера этих команд в вашей 
программе. При редактировании программы обращайте внимание на то, чтобы не 
использовать в своей программе дважды одни и те же номера фронтов. 

Перекрестные 
ссылки 
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Загрузка программы в режиме RUN 
Функция редактирования в режиме RUN позволяет загружать программный блок только в том 
случае, если S7�200 находится в режиме RUN. Перед загрузкой программного блока в режиме 
RUN подумайте о влиянии, которое оказывают изменения в режиме RUN на работу S7�200 в 
следующих ситуациях: 

- При удалении логики управления для некоторого выхода S7�200 сохраняет последнее 
состояние этого выхода до выключения S7�200 или его перевода в STOP. 

- При удалении скоростного счетчика или вывода последовательности импульсов, когда 
они работают, скоростной счетчик или вывод последовательности импульсов 
продолжает действовать до следующего включения или следующего перевода S7�200 в 
STOP. 

- Если вы удалили команду назначения прерывания, но не удалили программу обработки 
прерываний, то S7�200 продолжает выполнять программу обработки прерываний до 
выключения S7�200 или его перевода в STOP. Аналогично, при удалении команды 
отсоединения прерывания продолжают выполняться до выключения S7�200 или его 
перевода в STOP. 

- При добавлении команды назначения прерывания, которая включается битом первого 
цикла, это событие не активизируется до следующего цикла выключения/включения 
питания или перевода S7�200 из STOP в RUN. 

- При удалении команды разблокирования всех прерываний прерывания продолжают 
работать до следующего цикла выключения/включения питания или перевода S7�200 из 
RUN в STOP. 

- Если вы изменили адрес принимающего блока в таблице, и принимающий блок был 
активен при переключении S7�200 со старой программы на измененную, то S7�200 
продолжает записывать принимаемые данные по старому адресу. Команды чтения из 
сети и записи через сеть действуют таким же образом. 

- Любая логика, активизируемая битом первого цикла, выполняется только после 
следующего цикла выключения/включения питания или перевода S7�200 из STOP в 
RUN. Бит первого цикла устанавливается только при переходе в режим RUN, и функция 
редактирования в режиме RUN на него влияния не оказывает. 

 
Совет 
Чтобы вы могли загрузить свою программу в режиме RUN, S7�200 должен поддерживать 
редактирование в режиме RUN, программа должна быть скомпилирована без ошибок, и 
обмен данными между STEP 7-Micro/WIN и S7�200 должен происходить без сбоев.  
Вы можете загрузить в S7�200 только программный блок.  

 
Для загрузки вашей программы в режиме RUN щелкните на кнопке Download [Загрузить] на 
панели инструментов или выберите команду меню File > Download [Файл > Загрузить]. Если 
программа компилируется успешно, то STEP 7-Micro/WIN загружает программный блок в S7�
200.  

Выход из редактирования в режиме RUN 
Для выхода из редактирования в режиме RUN выберите команду меню Debug > Program Edit 
in RUN [Отладка > Редактирование программы в режиме RUN] и удалите метку рядом с 
этим пунктом меню. Если у вас есть несохраненные изменения, STEP 7-Micro/WIN предлагает 
вам продолжить редактирование, загрузить изменения и выйти из редактирования в режиме 
RUN, или выйти из редактирования без загрузки. 
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Отображение состояния программы 
STEP 7-Micro/WIN дает возможность наблюдать состояние программы во время ее 
исполнения. При наблюдении состояния программ редактор программ отображает состояние 
операндов команд.  

Для отображения состояния щелкните на кнопке Program Status [Состояние программы] на 
панели инструментов или выберите команду меню Debug > Program Status [Отладка > 
Состояние программы].  

Отображение состояния программы в LAD и FBD 
STEP 7-Micro/WIN предоставляет две возможности для отображения состояния программ в 
LAD и FBD:  

- Состояние в конце цикла: STEP 7-Micro/WIN запрашивает значения для отображения 
состояния в нескольких циклах, а затем обновляет отображение состояния на экране. 
Отображение состояния не отражает фактическое состояние каждого элемента во время 
исполнения. Состояние в конце цикла не показывает состояния памяти локальных 
данных и аккумуляторов. 

Для состояния в конце цикла значения состояния обновляются во всех режимах работы 
CPU. 

- Состояние во время исполнения: STEP 7-Micro/WIN отображает значения операндов во  
время исполнения команд в сегментах программы S7�200. Для отображения состояния 
во время исполнения выберите команду меню Debug > Use Execution Status [Отладка > 
Состояние во время исполнения].  

Для состояния во время исполнения значения состояния обновляются только при 
нахождении CPU в режиме RUN. 

 
Совет 
STEP 7-Micro/WIN предоставляет простой метод для изменения состояния переменной. 
Просто выберите переменную и щелкните правой кнопкой мыши для вызова контекстного 
меню.   

 
Настройка отображения состояния в программах LAD и FBD  
STEP 7-Micro/WIN предоставляет 
несколько возможностей для 
отображения состояния программы.  

Для настройки вариантов отображения 
выберите команду меню Tools > Options 
[Инструментальные средства > 
Возможности], а затем выберите 
закладку Program Editor [Редактор 
программ], как показано на рис. 8�2. 

  [Возможности]
Перекрестные ссылки] [Окно вывода] [Дерево команд] [Навигационная панель][Печать][Состоян.STL]

    [Общее]       [Проект]    [Цвета] [Редактор программ][Таблица символов][Блок данных][Табл. сост.]
[Сетка] [Предварительный просмотр]

[Ширина]
  [Символическая адресация]

[Отображать символ и адрес]

[Отображение состояния]

[Внутри команды]

 [Категория]
   [Все категории] [Шрифт]

     [Актив. табулятор]
[Норм. табулятор] [Тип]

[Стиль] [Стандартный]
[Образец текста]

[Размер]

[Разблокировать редактирование операнда после размещения команды]
    [Форматировать код STL при вводе]

[Сбросить все]    [Отменить]

    [Заголов. табл. перем.]
    [Ячейка табл. перем.]
[Комментарии]
 [Номер сегмента]
[Загол. сегм.]

 
Рис. 8�2. Возможности отображения состояния 
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Отображение состояния в STL 
Вы можете наблюдать исполнение своей программы на STL команда за командой. Для 
программы на STL STEP 7-Micro/WIN отображает состояние команд, которые видны на экране. 

STEP 7-Micro/WIN собирает информацию о состоянии из S7�200, начиная с первого оператора 
STL на верхнем краю окна редактора. По мере листания окна редактора вниз из S7�200 
собирается новая информация.  

STEP 7-Micro/WIN постоянно обновляет 
значения на экране. Для прекращения 
обновления выделите кнопку Triggered Pause 
[Пауза активизирована]. Текущие данные 
останутся на экране, пока вы не отмените 
выделение кнопки Triggered Pause. 

Настройка параметров, отображаемых 
в программе на STL  
STEP 7-Micro/WIN позволяет отображать 
состояние ряда параметров для команд STL. 
Выберите команду меню Tools > Options 
[Инструментальные средства > Варианты], 
а затем выберите закладку STL Status 
[Состояние STL]. См. рис. 8�3.  

      [Возможности]
     [Общее]       [Проект]    [Цвета] [Редактор программ][Таблица символов][Блок данных][Табл. сост.]

[Перекрестные ссылки] [Окно вывода][Дерево команд] [Навигационная панель][Печать][Состояние STL]

[Наблюдаемые значения] [Биты состояния команд]
    [Сост. операнда]

[Логический стек]

[Биты состояния команд]

   [Операнды]

[Количество операндов]

[Логический стек]

[Количество битов стека]

[Сбросить все]    [Отменить]

 [Деблокировка выхода]
[Бит SCR]

    [Бит области SCR]
    [Нулевой результат]
[Переполнение]

   [Отрицательный результат]
  [Деление на ноль]
   [Таблица переполнена]

[Чтение пустой таблицы]
  [Не BCD в целое число]
[Ошибка преобр. ASCII в Hex. ]

 
 Рис. 8�3. Возможности отображения состояния STL 

 
Использование таблицы состояний для наблюдения и 
изменения данных в S7�200 

[Таблица состояний]

[Адрес] [Формат]   [Текущее значение] [Новое значение]

Таблица состояний дает возможность 
считывать, записывать, принудительно 
присваивать значения и наблюдать 
переменные, когда S7�200 исполняет 
вашу программу. Выберите команду меню 
View > Component > Status Chart [Вид > 
Компонент > Таблица состояний] для 
создания таблицы состояний. На рис. 8�4 
показан пример таблицы состояний.  

Вы можете создать несколько таблиц 
состояний.      

 

Рис. 8�4. Таблица состояний 
STEP 7-Micro/WIN имеет на панели инструментальных средств пиктограммы для работы с 
таблицей состояний: Sort Ascending [Расположить по возрастанию], Sort Descending 
[Расположить по убыванию], Single Read [Однократное чтение], Write All [Записать все], Force 
[Принудительно присвоить значение], Unforce [Отменить принудительное присваивание], 
Unforce All [Отменить все принудительные присваивания] и Read All Forced [Прочитать все 
принудительно присвоенные значения].  

Чтобы выбрать формат для ячейки, выберите ячейку и щелкните правой кнопкой мыши для 
отображения контекстного меню. 
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Принудительное присваивание значений 
S7�200 позволяет принудительно присваивать значения отдельным или всем входам и 
выходам (битам I и Q). Кроме того, вы можете принудительно присвоить значения 16 битам 
памяти (V или M) или аналоговым входам или выходам (AI или AQ). Значения в памяти 
переменных и значения в битовой памяти могут принудительно присваиваться байтами, 
словами или двойными словами. Аналоговые значения принудительно присваиваются только 
двойными словами по границам байтов с четными адресами, например, AIW6 или AQW14. Все 
принудительно присвоенные значения хранятся в устойчивом к потере питания ЭСППЗУ 
модуля S7�200.  

Так как принудительно присвоенные значения данных могут изменяться в течение цикла 
(программой, актуализацией входов и выходов или в результате обработки коммуникаций), 
S7�200 снова записывает принудительно присвоенные значения в различные моменты 
времени внутри цикла.  

- Чтение входов: S7�200 применяет принудительно присвоенные значения к входам при 
их считывании. 

Исполнение программы

Обработка запросов на обмен
данными

Выполнение диагностики CPU

Записывает в выходы

Считывает входы

Цикл

 

- Исполнение логики управления в программе: 
S7�200 применяет принудительно 
присвоенные значения ко всем входам и 
выходам с непосредственным доступом. 
Непосредственно присвоенные значения 
применяются не более чем к 16 значениям в 
памяти после исполнения программы. 

- Обработка запросов на обмен данными: S7�
200 применяет принудительно присвоенные 
значения при всех обращениях на чтение или 
запись при обмене данными. 

- Запись в выходы: S7�200 применяет 
принудительно присвоенные значения к 
выходам при их записи. 

Для принудительного присваивания значений 
можно использовать таблицу состояний. Для 
принудительного присваивания нового значения 
введите это значение в столбец New Value [Новое 
значение] таблицы состояний, затем нажмите 
кнопку Force [Принудительно присвоить] на панели 
инструментов. Для принудительного присваивания 
существующего значения выделите это значение в 
столбце Current Value [Текущее значение], затем 
нажмите кнопку Force. 

Рис. 8�5. Цикл S7�200  

  
Совет 
Функция принудительного присваивания значений перекрывает команду непосредственного 
чтения или записи. Функция принудительного присваивания значений перекрывает также 
таблицу выходов, которая была сконфигурирована для перехода в STOP. Если S7�200 
переходит в STOP, то на выходе появляется принудительно присвоенное значение, а не 
значение, сконфигурированное в таблице выходов. 

 

Исполнение программы в течение определенного количества 
циклов 

Чтобы помочь вам в отладке программы, STEP 7-Micro/WIN дает возможность прогонять 
программу в течение определенного количества циклов.  
Вы можете заставить S7�200 выполнить только первый цикл. Это позволяет наблюдать 
данные в S7�200 после первого цикла. Для прогона первого цикла выберите команду меню 
Debug > First Scan [Отладка > Первый цикл].  
Вы можете заставить S7�200 выполнять вашу программу в течение определенного количества 
циклов (от 1 до 65 535 циклов). Это позволяет наблюдать программу, когда она изменяет 
переменные. Чтобы указать количество циклов, подлежащих выполнению, выберите команду 
меню Debug > Multiple Scans [Отладка > Несколько циклов].  



Устранение неисправностей аппаратуры и инструментальные средства для 
тестирования программ  

Программируемый контроллер S7-200. Системное руководство  241 

Указания по устранению неисправностей аппаратуры 
 
Таблица 8�1. Указания по устранению неисправностей аппаратуры для S7�200  
Симптом  Возможные причины Возможное решение 
Прекращение работы 
выходов 
     

■ Управляемое устройство 
вызвало бросок напряжения, 
который повредил выход 
 

■ Ошибка в программе 
пользователя 

■ Плохо или неправильно 
подключена проводка 

■ Чрезмерная нагрузка 
 

■ Принудительный режим работы 
выхода 

■ При подключении к индуктивной нагрузке 
(например, к двигателю или реле) 
необходимо использовать соответствующую 
гасящую цепочку. См. главу 3. 

■ Исправьте программу пользователя 
 

■ Проверьте и исправьте проводку 
 

■ Проверьте нагрузку относительно номинала 
для выходов 

■ Проверьте S7�200 на наличие 
принудительного режима для входов/ 
выходов 

На S7�200 загорелся 
сигнал SF (системная 
ошибка) 

В следующем списке приведены 
наиболее часто встречающиеся 
коды ошибок и их причины:  
■ Ошибка программирования 

пользователя 
- 0003 превышение контроля 

 времени 
- 0011 косвенная адресация 
- 0012 недопустимое 

 значение для числа с 
 плавающей точкой 

- 0014 Ошибка области  
■ Электрические помехи 

(от 0001 до 0009) 
■ Повреждение компонентов 

(от 0001 до 0010) 

Прочитайте код фатальной ошибки и обратитесь 
к Приложению C за информацией о типе ошибки: 
■ В случае ошибок программирования 

проверьте использование команд FOR, NEXT, 
JMP, LBL и сравнения. 

■ В случае электрических помех: 
- Обратитесь к указаниям по монтажу 
электропроводки в главе 3. Очень важно, 
чтобы панель управления была хорошо 
заземлена и чтобы высоковольтная 
проводка не шла параллельно с 
низковольтной проводкой. 

- Подключите клемму M в источнике питания 
датчиков 24 В постоянного тока к 
заземлению. 

Не включается ни один 
из светодиодов 

■ Сгорел предохранитель 
■ Перепутана полярность 

проводов 24 В  
■ Неправильное напряжение 

Подключите к системе измерительный прибор, 
чтобы проверить величину и длительность пиков 
перенапряжения. С помощью этой информации 
добавьте к своей системе разрядник 
подходящего типа. 
Подробную информацию о монтаже полевой 
проводки вы найдете в главе 3. 

Неустойчивая работа, 
связанная с силовыми 
устройствами  

■ Плохое заземление 
■ Прокладка проводки внутри 

шкафа управления 
■ Слишком малое время задержки 

для входных фильтров  

Обратитесь к указаниям по монтажу 
электропроводки в главе 3.  
Очень важно, чтобы панель управления была 
хорошо заземлена и чтобы высоковольтная 
проводка не шла параллельно с низковольтной 
проводкой. 
Подключите клемму M в источнике питания 
датчиков 24 В постоянного тока к заземлению. 
Увеличьте задержку входного фильтра в блоке 
системных данных.  

Сеть связи повреждена 
при подключении к 
внешнему устройству. 
Поврежден или порт на 
компьютере, или порт на 
S7�200, или кабель 
PC/PPI. 

Кабель связи может давать путь для 
протекания нежелательных токов, 
если все устройства, не имеющие 
гальванической развязки, напр., 
ПЛК, компьютеры или другие 
устройства, которые подключены к 
сети, не используют один и тот же 
опорный потенциал.  
Нежелательные токи могут вызвать 
ошибки связи и повреждения в 
цепях. 

■ Обратитесь к указаниям по монтажу 
электропроводки в главе  3 и к руководству 
по сетям в главе 7.  

■ Приобретите кабель PC/PPI, имеющий 
гальваническую развязку.  

■ Приобретите повторитель RS�485/RS�485 с 
гальванической развязкой, если вы 
соединяете установки, не имеющие общей 
электрической опорной точки.  

За номерами для заказа оборудования S7�200 
обратитесь к Приложению E.  

Другие 
коммуникационные 
проблемы (STEP 7-
Micro/WIN) 

Обратитесь к главе 7 за информацией об обмене данными в сети.  

Обработка ошибок 
 

Обратитесь к Приложению C за информацией о кодах ошибок. 
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